
The ALCHEMY.INI File
The initialization file ALCHEMY.INI was placed into your Windows directory when Alchemy was installed.    This file 
contains information about which options had which settings the last time Alchemy was used.    This file is maintained
by Alchemy and should not need to be modified by the user except in special cases.    Any section or item not 
mentioned here should not be changed.    The file contains sections, delimited by the brackets [ ], containing items as 
follows:

[Fonts]

Viewer=-13,400,0,Courier New
Lists=-13,400,0,MS Sans Serif

[Options]

ToolBar=1
StatusBar=1
ToolTips=1
Alchemist=1
FileDetails=0
HorzScrollBar=1

[Image]

ScrollBars=1
ScaleToGray=1
Invert=0

[CDR]

WriteToCDR=1
CompressData=1
CloseSession=0
WriteProtectCD=0
BufferSize=8
RecordingSpeed=1
ProgressMeter=0

[Build]

SkipLockedFiles=0
FileManager=
FileManagerClass=



About Alchemy Personal for HP
Alchemy, the Intelligent Information Manager for CD-R

"Alchemy fills a large hole in CD-R applications....it focuses on turning heaps of data into useful information."    CD-
ROM Professional, 1994

"Its indexing and retrieval capabilities set it apart from other CD-R backup packages."    Infoworld, 1995

"Finding the right data...demands an efficient search and retrieval engine.    Alchemy fills this gap by adding query-
by-example and Boolean full-text search capabilities to CD recording."      PC Magazine, 1994

Alchemy Personal for HP is the intelligent way to record your files on CD-R.    Retrieving files from a full 650 MB CD 
can be frustrating, unless you record with Alchemy!

With Alchemy Personal for HP, you can:

1) Archive seldom-used files on CD, and when you need them again, retrieve them in seconds.
2) Find files using full-text retrieval.    Forgot the filename?    No problem!
3) Fit over 1 Gigabyte on a 74 minute CD-R, using the built-in data compression.
4) Create professional-looking, self-contained CDs and send them to anyone.
5) Copy files from the network direct to CD, with confidence.

Alchemy Personal for HP was developed by IMR exclusively for the HP SureStore CD Writer, and is part of the 
award-winning Alchemy family of CD-R solutions for business.

For more information on other IMR products, click on The Alchemy Family of Products.

For information about the special HP upgrade offer, click on How To Upgrade.



About IMR
Information Management Research (IMR), based in Englewood, Colorado, develops and markets software retrieval 
and archival products for CD-Recordable drives.    IMR's flagship product, Alchemy, addresses the indexing, 
management, retrieval, archiving, and backup of documents on PC-based recordable CDs.

In 1993, IMR identified the CD-Recordable software market as a logical extension for its core indexing and retrieval 
technology.    One common complaint about CD-ROMs has been the slow access and retrieval performance to date.   
The IMR development team has extensive experience with retrieval and archival search engines, and was able to 
optimize the software for optical media, resulting in stunning performance improvements in file retrieval operations.

IMR also realized that there was no shrink-wrapped, end-user application for CD-Recorders.    Indeed, the process of 
recording your own CDs involved the purchase of very expensive, complex software from more than one vendor.    
Alchemy is intended to provide the first complete data management system for CD-Recorders that is affordable and 
easy to operate.



Advanced Topics
The ALCHEMY.INI File
Using Windows 95
Indexing Details
Space Requirements
The Stop List



Build Menu
Click on any menu item for further information.



Select this option to build the indexes and profiles for the current data in the Contents window and to write the 
database to the CD-Recorder or hard drive.

This option starts the Build dialog.



CD-Recording Tips
There are several things you can do to increase the performance of your CD-ROM Recorder using Alchemy 
software.

Use a large/fast hard disk.    Alchemy uses space on the hard disk to store temporary files when writing to a 
CD.    A faster hard disk insures that the data is presented to the CD-Recorder fast enough to keep it busy (and 
eliminate data underrun).    Most computers capable of running Alchemy use a hard disk with a seek time of 15 
milliseconds or less, which should be fast enough.    A hard disk can be made to perform better by using a 
defragmenting utility often.
Use a second SCSI controller.    If you have a SCSI hard disk as your Alchemy drive, using a second SCSI 
controller for the CD-Recorder insures that the data is presented to the CD-Recorder fast enough to keep it busy.
Don't use Stacker, DoubleSpace or DriveSpace.    While these programs are useful, they slow down access to 
files on the disk and increase the chances of data underrun.
Use the SCSI controller that came with your CD-Recorder.    The manufacturer may not fully support other 
SCSI adapters.
Use the SCSI drivers that came with your CD-Recorder.    Other drivers may not fully support your drive.
Close all files before attempting to record.    Although Alchemy can handle closed or locked files without a 
data under-run occurring, it makes sense to check first before recording.
Don't run other programs while recording.    All programs running under Windows use the processor or 
resources, even when minimized.
See Also: Space Requirements



Contacting Customer Support
For questions about your CD-Recorder drive or SCSI, please contact the vendor of your drive.

For questions related to Alchemy, call:

(970) 339-7150 voice
(970) 339-7022 fax
7:00 AM - 6:00 PM MST Mon. - Fri.

If calling to report an error, please have the full text of any error messages and a description of the events leading to 
the error.    Customer support personnel may need further information such as the hardware configuration and 
contents of several system files, so please call from the computer where the error occurred if at all possible.

If there are features you'd like to see in Alchemy, a feature request form can be printed from the Requesting 
Features topic and mailed to IMR for consideration.



Alchemy Help Contents
 

Essentials Concepts you will need to 
know to use Alchemy

Technical Support What to do if you have a 
question or a problem

The User Interface Information on menus, the 
toolbar, keyboard shortcuts, 
and the dialogs.

Tasks Step-by-step directions for 
using Alchemy

Error Messages Troubleshooting errors
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Add Folder
Click on any control for further information.



Build Database
Click on any control for further information.



Build Options
Click on any control for further information.



CD-R Info
Click on any control for further information.



Copying Files
Click on any control for further information.



Database Definition
Click on any control for further information.



Database Info
This window contains summary information about your database.

Document Count is the number of files written to the database.

Tracks Written is the number of tracks written to the CD.    Each CD can hold up to 99 tracks.

Uncompressed Size is the total number of bytes taken up by the included files.

Compressed Size is the number of bytes for the included files after compression has been applied.



Fonts
Click on any control for further information.



Lookup
Click on any control for further information.



Preferences
Click on any control for further information.



Print
Click on any control for further information.

See Also: Printing a document



Properties
Click on any control for further information.



Query
Click on any control for further information.

See Also: Simple queries, Complex queries



Retrieving Files
Click on any control for further information.

See Also: Retrieving files, Copying selected text



The Contents Window
Click on any area of the screen for further information.



Dialogs
Designing the Database

Database 
Definition

From Edit/Database Definition....
Used to modify the title of a database.

Building the Database

Add Folder From Edit/Add Folder....
Used to add folders to the database.

Properties From Edit/Properties
Used to set/view folder & document 
properties.

Build Database From Build/Build Database....
Used to build and index the database 
using the data in the Contents window.

Build Options From Build/Build Database.../Options...
or Build/DataGrabber.../Options...
Used to set build options.

Database Info From View/Database Info...
Used to view database statistics.

CD-R Info From Build/CD-R Database.../Info....
Used to view CD-Recorder information.

Copying Files Shown during the build operation if any 
file is unavailable for building.

Contents 
Window

Shown in the main window. Contains a 
hierarchical view of the contents.

Searching the Database

Query From Search/Query....
Used to query the database.

Lookup From Search/Query.../
Lookup....    Used to interactively look up 
words in the indexes.

Retrieve Files From File/Retrieve Files....
Used to copy documents or folders from 
the database.

Print From File/Print....
Used to print documents from the 
database.

Options and Information

Preferences From Options/Preferences...
Used to set various general and viewer 
options.

Database Info From View/Database Info....
Used to show various information about 
the current database.

Fonts From Options/Fonts....
Used to select the font used for text 
viewing.



Document Icons
All folders and documents in Alchemy are assigned an icon based on the file type.    The following icons are used in 
Alchemy.

This icon is used to represent a 
closed folder.    Any documents 
contained in this folder are not 
visible until it is opened by 
double-clicking.

This icon is used to represent an 
open folder.    If it contains any 
files, they will be visible below it.

This icon is used to represent a 
master document containing 
other, linked documents.    These 
documents are not visible until 
the master document is opened 
by double-clicking.

This icon is used to represent an 
open master document.    The 
linked documents will be visible 
below it.

This icon is used to represent 
documents containing text, such 
as word processing documents 
or ASCII files.    Any file not 
identified as one of the other 
types is also represented by this 
icon.

This icon is used to represent 
images.    All supported image 
formats will use this icon.

This icon is used to represent 
spreadsheets.    All supported 
spreadsheet formats will use this 
icon.

This icon is used to represent 
programs.

This icon is used to represent 
sound (WAV) files.

This icon is used to represent 
video (AVI) files.



Edit Menu
Click on any menu item for further information.



Select this option to copy selected text from the active document to the Windows clipboard.    This text 
replaces the previous contents of the Clipboard.

Copy is only available if you have selected any text within a displayed document.



Select this option to change the database title.

This option starts the Database Definition dialog.



Select this option to search for specified text in the displayed document.

Find is only available when viewing a text document.



Select this option to add a Folder to the database.

This option starts the Add Folder dialog.



Select this option to delete the selected folder or document.    If the splitter bar is used to open two Contents 
panes, this option will only work on the left-hand pane.



Select this option to start a copy of the Windows Notepad application and append selected text from the 
displayed document to it.    You may continue to append text to the same Notepad document from any number 
of Alchemy text documents, up to Notepad's file size limit of 50K.

Gather is not available if you have not selected any text within a displayed document. 



Select this option to change or view the properties for the selected folder or document.

This option starts the Properties dialog.



Select this option to select all of the text in a document for purposes of Copying or Gathering.



Select a position for adding a new folder to the database.
Before Current Selection adds the new folder before the currently selected folder or file.
After Current Selection adds the new folder after the currently selected folder or file.



Click here to enter the new folder's title.    Folder titles can contain up to 255 characters in mixed upper and 
lower case.



Click the Build button or press Alt-B to start the process of indexing, merging, compressing and copying the 
database to CD-ROM.



Click the Cancel button or press Esc to cancel the build process.



Click the Close button or press Esc to close the Build Database dialog.



You can choose to build the database directly to the CD-ROM, or build it to the hard drive for testing.    If you 
save the database to the hard drive, it can be written to the CD-ROM next time you build.



Click the Options... button or press Alt-O to change the database build options.

This option starts the Build Options dialog.



Click the CD-R... button or press Alt-C to view or edit the options specific to your CD-Recorder.



Check this option if you wish to close the CD-ROM after recording.    The CD-ROM cannot be read in another 
CD-ROM drive until you close the session.

Warning: Closing the CD-ROM will consume 23 megabytes if the session contains more than one buffer of 
data, or 14 megabytes if the session has only one buffer.



Check this option to compress the database as it is recorded to CD-ROM or hard disk.



Check this option to record the database as one session on the CD-ROM.    This option must be checked if:
You wish to read the CD-ROM on older drives that do not support multiple sessions (including most 
single-speed CD-ROM drives.
You wish to use the CD-ROM to send to a mastering facility to make copies.

Warning:    You must have free hard disk space in excess of the amount of data in the database to build the 
database as a single session.



Click the Info... button or press Alt-I to view CD-Recorder information.

This option starts the Disc Info dialog.



Check this option to finalize the CD-ROM after writing.

Warning: A write-protected CD-ROM can never be written to again.



Click the Save button or press Alt-S to save the build options.



Select the temporary buffer size.    The smallest possible buffer is 8 megabytes.    The buffer could be as large 
as the size of a CD-ROM to record the entire build in one session.    This space must be available for use on 
Alchemy's hard drive at the time you start a build.



Check this option to skip any files during the build process that are missing or in use by another application.    
Any skipped files will be noted in the log file, in the current database directory.



This area shows how much space remains on the current CD-ROM or hard drive.



Select the CD-Recorder speed from this drop-down list.    The speeds available will be dependent on your CD-
Recorder.



This area is used to display the progress of the entire build.



Click the Save button or press Alt-S to save the session into the database.

Note:    If you do not write the session to CD immediately after building, you should defragment your hard disk 
to allow the best possible search performance.    To defragment your hard disk, exit Windows and run the 
DEFRAG program that comes with MS-DOS.    See your MS-DOS manual for further information.



Check this option to write the database to the CD-Recorder.



Click the Cancel button or press Esc to cancel the dialog box.



Click the Save button to save the color settings.



Select the destination drive and directory.    Documents will be copied to their original DOS filenames in the 
selected directory.    Folders will be copied as subdirectories in the selected directory.



Click the Network... button to select network drive connections.    This button may not appear if your PC is not 
connected to a network.



This drop-down list box allows you to select what to retrieve.    Your choices include:

Document will retrieve the currently-highlighted document.

Query Results will retrieve the documents in the Query Results List.

Folder Contents will retrieve the entire folder's documents, subfolders, and their contents, or a compound 
document and linked documents..



Click the Cancel button or press Esc to cancel the file copy operation.



Click the Retry button or press Alt-R to retry the copy operation after making the file available.



Click the Skip button or press Alt-S to skip this file.    The file will be removed from the contents and will not be
included in the database.



Click the Skip All button or press Alt-A to skip all missing or locked files for this build.



Enter a file name for your database.    Enter up to eight valid DOS filename characters, with no extension.    
This field is required.    Alchemy creates a file in its directory using this name and the extension ALD, and also
creates a subdirectory under Alchemy's directory.    This name cannot be changed once created.



Select the Info button or press Alt-I to see further information about your Alchemy database.



Click here to enter the Title for your database.    Enter up to 80 characters.    The title can be any descriptive 
text, and is displayed in the title bar of the Contents window.



This area contains a list of all files and directories currently written to the CD-ROM disc.



Click the Eject button or press Alt-E to eject the CD from the CD-Recorder.



This area contains the manufacturer's name of the CD-Recorder.



Click the Refresh button or press Alt-R to refresh the file listing.



This area contains information about the space remaining on the current CD-ROM.



This area contains the volume label of the currently-mounted CD.



This list shows all fixed-width fonts available on the system.



This area shows a sample of the selected font, style, and size.



This list shows all of the available sizes for the selected font.



This list shows all the available font styles for the selected font.



Click the Help button or press Alt-H to get help.



Click the Cancel button to stop the build process.

Note:    The cancel command may not have an immediate effect.    The cancel command should be used 
sparingly, since the database or the CD-ROM may be left in an indeterminate state.



This area shows the elapsed time of the current build process.    The time is in hours:minutes:seconds.



Either
Select a word from the list to be used in the query.

Or
Type a word in the input area.    The word list will scroll as you type.    You can completely type the word, 
or type just enough to allow you to select the word from the list.



The Maximize button  on a window expands that window to fill the Alchemy window.



The Minimize button  on a window collapses that window to an icon.



Click the OK button or press Enter to accept the choices in the dialog box.



Enable this option to close any launched applications when Alchemy closes.



Enable this option to have the Query Results list viewers jump to the first occurrence of the search term in the 
viewed document.



Enable this option to modify monochrome TIF images to gray scale.    For scanned images, this can make 
them much more readable by performing "anti-aliasing", which can soften jagged lines.



Enable this option to view documents with a single mouse click.    If disabled, you must double-click to view 
any document except master compound documents.    Double-clicking on a master compound document 
expands and contracts it like a folder.    To view it, click on it and click the View icon on the toolbar.



Enable this option to synchronize the Query Results list with the Contents.    As you view a document in the 
Query Results list, the Contents tree expands and the highlight is moved to the viewed document.



Enter the number of print copies desired.



This label shows which printer is the current Windows default printer.



Select which range to print.    Your options are:
All - Select this option to print the entire document.
Selection - Select this option to print the highlighted text.
Pages - Select this option to specify starting and ending page numbers.



Click the Setup button or press Alt-S to start the printer setup dialog.



This drop-down list box allows you to select what to print.    Your choices include:

Document will print the currently-highlighted document.

Query Results will print all or selected documents in the Query Results List.

Query Results List will print the results list itself.

Folder Contents will print all of the documents in the highlighted folder.



Enable this option to send the printout to a file rather than to a printer.



Edit this field to rename the currently selected folder.    If the splitter bar is used to open two Contents panes, 
this option will only work on the left-hand pane.    The new name will be visible only if 
Options/Preferences.../Show File Details is disabled.



Click the Clear button or press Alt-C to clear all search fields in the Query.



Click the Lookup button or press Alt-L to interactively look up a word in the field that has the cursor.

This option starts the Lookup dialog.



Click the Search button or press Alt-S to start the search.



This area contains the Query Template.    Use the File Name field to search for DOS file names.    Use the 
Document Title field to search for document titles or Windows 95 long file names.    Use the Full Text field to 
search for a document's contents.



Click here to enter the new session title.



Click the Select All button or press Alt-A to select all the items on the list.



The highlighted file has been selected in the File Manager or Explorer.    This file will be added to the Contents 
window by dragging and dropping.



The splitter bar is used to split the Contents Window into up to four distinct panes.    The top one or two panes 
contain the Contents tree.    The bottom left pane contains a file viewer, which can contain images, text or 
spreadsheets.    The bottom right pane contains a profile card for the document in the viewer pane.

To use the splitter bar, move the mouse over the splitter bar.    The mouse cursor will change, indicating that 
you can click the primary mouse button and drag the splitter bar in either of two directions.



The Contents tree shows a hierarchical view of the folders and files within a database.    A database can have 
two trees, separated by a splitter bar.    Within a tree, you can perform the following actions:

Add files Add files to a folder by dragging 
files from File Manager or 
Explorer to drop on a folder.

Arrange files and 
folders

Arrange files and folders by 
dragging them to a new location 
in the tree.

Rename folders Rename folders by clicking on 
the folder name and selecting
Properties from the Edit menu.

View files View any file by clicking on the 
file name or by pressing the 
Enter key on a highlighted 
document.

Expand and 
collapse the tree

Expand and collapse sections of 
the tree by double-clicking on a 
folder icon.



The Contents title bar contains the title of the current database.



This pane contains the viewer.    All supported documents can be viewed here.



This pane contains the profile card for the file being viewed.



The viewer title bar contains the name of the file being viewed.



Error Messages
You may encounter error messages that are not in this list.    If so, they are probably Windows error messages.    
Consult your Windows manual for any message not listed here.

Alchemy Error Messages

Cannot copy file
Cannot create directory
Cannot create file
Cannot create temporary file
Cannot open file
Cannot position file
Cannot read from file
Cannot remove file
Cannot rename file
Cannot write file
Insufficient space on CD
Memory Exhausted
Out of Memory
Printer not ready
Printer out of paper
Warning - disk or CD space

SCSI Error Messages

Blank error
Command aborted
Hardware failure
Illegal request
Miscompare error
No sense
Recovered error on medium
Unit attention
Unit not ready
Unrecovered error on medium
Vendor reserved error
Volume overflow

CD-Recorder Error Messages

Absorption control error
Application code conflict
Attempt to cross track-boundary
Bad volume descriptor
Barcode reading error
Buffer under run
Calibration area almost full
Calibration area full
Can't recover from leadin area
Can't recover from leadout area
Can't recover from optical power calibration area
Can't recover from program memory area
Can't recover from track
Cannot read medium: unknown format
Command now not valid
Command sequence error



Communication failure
Current command aborted
Current program area empty
Data track length error
Diagnostic failure
Disc write protected
DOS memory unavailable
Drive not ready
Dummy sectors added
End of medium reached
End of user area encountered on this track
Eprom failure
Error loading driver
Fixation failed
Illegal field in command list
Illegal medium
Illegal mode for this track
Illegal sector size for command
Illegal track
Illegal track mode
Illegal track number
Illegal transfer length
Internal controller error
Invalid LUN
Invalid bits in identify message
Invalid command
Invalid field parameter list
Invalid sector address
Invalid start address
Link area encountered
Medium changed
Medium format corrupted
Medium load or eject failed
Medium not present
Medium removal is prevented
Mode parameters changed
Monitor ATIP error
No EFM at search address
Operator medium removal request
Optimum power calibration error
Parameter list length error
Parameter list too large
Positioning error
Power on or self test failure
Power-on reset or bus reset occurred
Program area not empty
Recovered read data with retries
Recovered read with ECC correction
Recovery needed
Request for fixation failed
SCSI parity error
Sector size format conflict
Stopped on non-data sector



Track following error
Tray out
Unable to read TOC, PMA or subcode
Unrecovered read error
Verify failed
Write append error
XCD engine already in use



Absorption control error

Indicates that an error might have occurred in the recorded data that was written, caused by laser power 
clipping.



Application code conflict

The Disc Application Code does not match the Host Application Code.



Attempt to cross track-boundary

The transfer length by a write-track command does not match the free space length in the track.



Bad volume descriptor

Indicates that the current CD disc has been corrupted.    This may indicate a hardware problem.



Barcode reading error

Indicates that an error occurred during barcode reading.    The medium may be damaged.



Blank error

Indicates that the drive encountered blank medium or format-defined end of data indication when reading or 
the drive encountered a non-blank medium while writing.



Buffer under run

Indicates that the write action stopped because the cache buffer emptied.



Calibration area almost full

Indicates that a few Optimum Power Calibration areas are left.



Calibration area full

Indicates that the calibration area is full.    No further writes can be performed on this disc.



Can't recover from leadin area

Indicates that recovering from a corrupted leadin area failed.



Can't recover from leadout area

Indicates that recovering from a corrupted leadout area failed.



Can't recover from optical power calibration area

Indicates that recovering from a corrupted optical power calibration area failed.



Can't recover from program memory area

Indicates that recovering from a corrupted program memory area failed.



Can't recover from track

Indicates that recovering from a corrupted track failed.



Cannot copy file

Alchemy received an error while attempting to copy a file.    This could indicate a hardware problem.

If the file is on a CD-ROM, the disc may be scratched or dirty.    Cleaning the disc may fix the problem.    If the 
file is on the hard disk, the DOS program Scandisk or a similar utility may be used to diagnose the problem.



Cannot create directory

Alchemy received an error while attempting to create a directory.    This could indicate a hardware or software 
problem.

The hard disk may be full.    If so, you will need to make additional space available.    If there is space 
available, there may be a hardware problem with the disk.    The DOS program Scandisk or a similar utility 
may be used to diagnose the problem.



Cannot create file

Alchemy received an error while attempting to create a file.    This could indicate a hardware or software 
problem.

The hard disk may be full.    If so, you will need to make additional space available.    If there is space 
available, there may be a hardware problem with the disk.    The DOS program Scandisk or a similar utility 
may be used to diagnose the problem.



Cannot create temporary file

Alchemy received an error while attempting to create a temporary file.    This could indicate a hardware or 
software problem.

The hard disk may be full.    If so, you will need to make additional space available.    If there is space 
available, there may be a hardware problem with the disk.    The DOS program Scandisk or a similar utility 
may be used to diagnose the problem.



Cannot open file

Alchemy received an error while attempting to open a file.    This could indicate a hardware problem.

If the file is on a CD-ROM, the disc may be scratched or dirty.    Cleaning the disc may fix the problem.    If the 
file is on the hard disk, the DOS program Scandisk or a similar utility may be used to diagnose the problem.



Cannot position file

Alchemy received an error while attempting to seek within a file.    This could indicate a hardware problem.

If the file is on a CD-ROM, the disc may be scratched or dirty.    Cleaning the disc may fix the problem.    If the 
file is on the hard disk, the DOS program Scandisk or a similar utility may be used to diagnose the problem.



Cannot read from file

Alchemy received an error while attempting to read from a file.    This could indicate a hardware problem.

If the file is on a CD-ROM, the disc may be scratched or dirty.    Cleaning the disc may fix the problem.    If the 
file is on the hard disk, the DOS program Scandisk or a similar utility may be used to diagnose the problem.



Cannot read medium: unknown format

Indicates that the drive could not read the information from the device or medium necessary to execute the 
current command.



Cannot remove file

Alchemy received an error while attempting to remove a file.    This could indicate a hardware or software 
problem.

The file may be locked or marked as hidden, system, or read-only.    Otherwise, there may be a hardware 
problem with the disk.    The DOS program Scandisk or a similar utility may be used to diagnose the problem.



Cannot rename file

Alchemy received an error while attempting to rename a file.    This could indicate a hardware or software 
problem.

The file may be locked or marked as hidden, system, or read-only.    Otherwise, there may be a hardware 
problem with the disk.    The DOS program Scandisk or a similar utility may be used to diagnose the problem.



Cannot write file

Alchemy received an error while attempting to write to a file.    This could indicate a hardware or software 
problem.

The hard disk may be full.    If so, you will need to make additional space available.    If there is space 
available, there may be a hardware problem with the disk.    The DOS program Scandisk or a similar utility 
may be used to diagnose the problem.



Command aborted

Indicates that the CD-Recorder aborted the command.    The system may be able to recover by trying the 
command again.



Command now not valid

Indicates that the command is not valid.



Command sequence error

Indicates that the previous command is not allowed in the sequence.



Communication failure

Indicates that a communication error between the SCSI controller and the servo prevented the command from
being performed.



Current command aborted

Indicates that the current command is aborted due to the ABORT message received during the message out 
phase.



Current program area empty

Indicates that the command could not be executed due to an empty program area.



DOS memory unavailable

Indicates that there is not enough DOS memory to load a required DLL.    Close all open programs and try the 
operation again.



Data track length error

Indicates that the track length is longer, because the track written was smaller than the minimum 300 blocks.



Diagnostic failure

Indicates that a device self-test failed, either as a result of a power-on self-test sequence, or as the result of 
the SEND DIAGNOSTICS command with the self-test bit set.



Disc write protected

The current disc is write-protected and cannot be written to.



Drive not ready

Indicates that the drive is temporarily not able to perform the desired operation.



Dummy sectors added

Indicates that during writing, dummy blocks are added to meet the minimum track size.



End of medium reached

Indicates that during writing the end of medium is detected or the amount of tracks reached the limit of 99.



End of user area encountered on this track

Indicates that the requested block exceeds the current track.



Eprom failure

Indicates that the non-volatile memory failed.



Error loading driver

Indicates that the CD-Recorder driver could not be found.    Reinstall Alchemy.



Fixation failed

Indicates that a request for fixation failed because of existing blank area on disc.



Hardware failure

Indicates that the CD-Recorder detected a hardware failure while performing a command or a self-test.



Illegal field in command list

Indicates that either:
One or more of the reserved bits in the Command Descriptor was set, or than an option was selected 
that is not supported by the CD-Recorder.

Or
During audio playback the information type has changed, or that the starting address for audio playback 
is not within an audio track.



Illegal medium

Indicates that a drive contains a disc other than a Write-Once disc.



Illegal mode for this track

Indicates that the data on the track is not according the mode which is requested by the command.



Illegal request

Indicates that there was an illegal parameter in the SCSI command.



Illegal sector size for command

The selected sector size is not allowed for this command.



Illegal track

Indicates that the track being accessed does not exist.



Illegal track mode

Indicates that the selected Track Mode is invalid.



Illegal track number

Indicates an invalid track number in a command descriptor block.



Illegal transfer length

Indicates that the transfer length in the command descriptor block would overflow the write buffer.



Insufficient space on CD

There is not enough remaining space on this CD-ROM to continue the build.    The unbuilt documents should 
be deleted from the Alchemy Contents window, and the build restarted to finish this CD.

For further instructions, see Space Requirements.



Internal controller error

Indicates that the controller detected an error which could not be otherwise explained.



Invalid LUN

Indicates that the Logical Unit Number in the Command Descriptor was non-zero.



Invalid bits in identify message

Indicates that the Identify message is corrupt.



Invalid command

The previous SCSI command is not supported by this device.



Invalid field parameter list

Indicates that the parameter list contained one or more reserved bits set to 1, or that an option was set and 
was not supported by the CD-Recorder.



Invalid sector address

Indicates that one or more of the sector addresses requested by the last READ, WRITE, SEEK, or VERIFY 
commands extends beyond the end of the disc.



Invalid start address

No explanation available for this error message.    Contact your hardware or software vendor.



Link area encountered

Indicates that during reading the link area is encountered.



Medium changed

Indicates that the disc may have changed since the last command was issued.



Medium format corrupted

Indicates that the drive could not read/write the requested information from/to disc due to a corrupted or 
unknown format.



Medium load or eject failed

Indicates that loading or unloading of the disc failed.



Medium not present

Indicates that no disc is in the drive.



Medium removal is prevented

Indicates that medium removal is prevented.



Memory Exhausted

Alchemy could not obtain the memory it needs to function.

Several things could help this problem.    Exit Windows and restart.    When running Alchemy, run as few other
programs as possible.    Try building after dragging in less files.



Miscompare error

Indicates that the CD-Recorder device detected a mismatch of settings used to read source data on the 
medium.



Mode parameters changed

Indicates that a mode change has been done by another initiator.



Monitor ATIP error

Indicates that an error occurred in the recorded data that was written, probably caused by dust.



No EFM at search address

Indicates that during reading or play-back no EFM signal was present.



No sense

Indicates that there is no specific sense key information to be reported from the designated logical unit.



Operator medium removal request

Indicates that the operator requested to unload the disc.



Optimum power calibration error

Indicates that power calibration failed.    This could indicate:
Wrong Write-Only medium installed.
Laser failure.
Drive failure



Out of Memory

Alchemy could not obtain the memory it needs to function.

Several things could help this problem.    Exit Windows and restart.    When running Alchemy, run as few other
programs as possible.    Try building after dragging in less files.



Parameter list length error

No explanation available for this error message.    Contact your hardware or software vendor.



Parameter list too large

Indicates that the CD-Recorder is not capable of processing the parameter list due to not enough RAM.



Positioning error

Indicates that a seek to a requested location on the disc failed.



Power on or self test failure

Indicates that a power-on self-test sequence failed.



Power-on reset or bus reset occurred

Indicates that a power-on reset or a bus reset has occurred since the last command was issued.



Printer not ready

Alchemy could not communicate with the printer.

Check to see that the printer is online and connected.



Printer out of paper

Alchemy has detected that the printer is out of paper.

Check the printer for paper out or a paper jam.



Program area not empty

Indicates that the current program area contains tracks.



Recovered error on medium

Indicates that the last command completed successfully with some recovery action performed.
During read, it indicates that an ECC correction or retry was done.
During write, it indicates that the track length is longer because not enough blocks were sent to the 
recorder to meet the minimum track length of 300 blocks.



Recovered read data with retries

Indicates that the previous READ command required data recovery, which was accomplished by additional 
READ commands.



Recovered read with ECC correction

Indicates that the previous READ command required data recovery, which was accomplished using ECC 
correction.



Recovery needed

Indicates that the CD-Recorder detected during power-up that the device was writing during the last power-
down.    The medium format could be corrupted.

This error is vendor-specific and could be caused by an unknown error.    Contact your CD-Recorder vendor 
for further information.



SCSI parity error

Indicates that the controller detected a parity error.



Sector size format conflict

Indicates that during writing, a sector was received and a conflict was detected between the header 
information and the actual sector size.



Stopped on non-data sector

During read, data transfer is stopped because a read of a non-data block was attempted.



Track following error

Indicates that the focusing or radial tracking did not succeed.



Tray out

Indicates that the drive's tray is out.



Unable to read TOC, PMA or subcode

Indicates that the drive was unable to read the TOC, PMA, or subcode of the current disc.



Unit attention

Indicates that either the disc or drive operating parameters have been changed since the last command 
issued.



Unit not ready

Indicates that the logical unit addressed cannot be accessed.    If the CD-Recorder is external, insure that it is 
powered on.



Unrecovered error on medium

Indicates that the command terminated with a non-recovered error condition that was probably caused by a 
flaw in the medium or an error in the recorded data.



Unrecovered read error

Indicates that the previous READ command failed, probably due to a flaw in the disc.



Vendor reserved error

Indicates that a vendor-specific error occurred.    Contact the vendor of your CD-Recorder for further 
information



Verify failed

Indicates that the VERIFY command was not successful.



Volume overflow

Indicates that the CD-Recorder device has reached the end of volume during writing or reading.



Warning - disk or CD space

These messages indicate that the hard disk or CD-ROM may not have enough space to complete the build.

If this message refers to the hard disk, make more space available on the Alchemy hard disk.

If this message refers to the CD-ROM disc, you may proceed with the build.    If compression is enabled, there 
may be enough room for the documents.

See Space Requirements for further information.



Write append error

Indicates that an append by a WRITE command during writing failed.



XCD engine already in use

Indicates that the XCD.DLL is in use by another program.    Exit Windows, reboot, and restart Windows.



Essentials
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CD-Recording Tips
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Extended Support Programs
IMR offers free technical support for the first 30 days, starting when you register the product with IMR or call us for 
the first time.    Before your complimentary support period expires, call IMR Sales at 1-303-689-0022 or your 
authorized reseller to subscribe to an Extended Support Program (ESP).

ESP is good for one year, and includes:

Unlimited product support via phone or FAX.
Access to the IMR BBS.
Free maintenance releases.
Generous discounts on product upgrades.

ESP is sold one per Alchemy or DataGrabber license.



Features
Intelligent Full Text Search - Powerful search and retrieval capabilities allow instant access to information stored 
anywhere on the CD-ROM.    Compressed inverted indices, query optimization, Boolean search operators, wild cards,
dynamic feedback, intermediate search results, search refinement, undo functions, full search history maintenance, 
search scope management and auxiliary filters result in a highly effective search engine.    The information managed 
by the system becomes both DOS directory structure and application independent.

Flexible Architecture - Alchemy supports a totally flexible architecture.    The term database refers to data (i.e. files 
or documents) which is grouped together and organized for rapid search and retrieval.    A single CD may hold 
multiple databases.    Databases can be organized into an environment similar to a filing cabinet containing Folders 
and Sub-Folders.    Each folder can hold any number of Sub-Folders and documents, limited only by system 
resources.

Full Text Batch Indexer - A new patent pending indexing engine has been introduced to provide faster access to 
documents on a CD and reduce storage overhead.    For example, full-text index overhead is typically less than 5%, 
allowing more room for your data and enabling superior retrieval performance.    Documents are batch indexed in 
parallel and indices compressed using proprietary compression algorithms before databases are updated.    The 
result is vastly improved indexing throughput and reduced network traffic.    Full Boolean operations can be performed
on indices while still in compressed form.    Radix compression of glossary, dynamic pointer size and incremental 
index updates are used to reduce disk overhead and increase full-text search and indexing speeds.

Data compression - Files are compressed before they are written to CD.    Compression is performed on-the-fly and 
is automatic, with no degradation of indexing speed.    Compression results will vary, however, 2:1 compression of 
word processing and spreadsheet files is typical.    ASCII text files will compress up to 8:1.    Most image files are 
already compressed and will be passed over.

File Viewers - Alchemy includes integrated viewers for over 30 popular word processing, spreadsheet, and image 
file formats.    This enables anyone to view a file's contents without requiring the native application.    Thus, you can 
distribute PC files on CD for others to view, print, copy, or restore.    Tight integration results in very fast viewing 
performance.

Integrated CD Recording - Alchemy is the first indexing and retrieval software with integrated CD recording.    
Advanced software technology developed by IMR prevents "buffer under-run" from ruining a CD.    Alchemy writes its
database files in tracks to conserve space on the CD for data.    CD-ROM multi-session writing is also supported.    
The user can configure variables such as recording speed, track size, Close Session, and Write-Protect CD.



File Menu
Click on any menu item for further information.



Select this option to delete the entire database, including the folder structure, field definitions, lookup tables, 
stop list and templates.

You will be prompted for confirmation before the database is deleted.



Select this option to close the current database and exit the program.



Select this option to run the Windows Explorer program.    Explorer is used as a drag and drop source for files 
added to the database, but another drag and drop source can be used by modifying ALCHEMY.INI.

If the Explorer starts in an unacceptable location, move and size it and then save settings.    The next time 
Explorer is used from Alchemy, it will start at your chosen location and size.

Alchemy will use the File Manager if run under Windows 3.1.



Select this option to run the Windows File Manager program.    File Manager is used as a drag and drop 
source for files added to the database, but another drag and drop source can be used by modifying 
ALCHEMY.INI.

If the File Manager starts in an unacceptable location, move and size it and then save settings.    The next time
File Manager is used from Alchemy, it will start at your chosen location and size.

Alchemy will use the Explorer if run under Windows 95.



Select this option to print Query Results, selected text from displayed documents, entire documents, or 
images.

This option starts the Print dialog.



Select this option to select a printer and a printer connection from the list of installed printers. You can install 
printers and configure ports through the Windows Control Panel.    If a FAX board is configured as a printer on 
your system, a document can be printed to the FAX board to send it as a FAX.

Printer Setup is also available from the Print command.

For more information, choose the Help button from the Printer Setup dialog box.



Select this option to retrieve documents or folders from the database.    It allows you to navigate your hard disk
and select a location where the currently selected document or folder will be copied.    The file names will 
default to the original DOS name of the documents or folders before they were added to the database.    You 
may, however, save a document under any name.

Any document retrieved from the database will be in its original file format.

This option starts the Retrieve Files dialog.



Select this option to save any changes to the Profiles.    You will also have the opportunity to save changes 
after each Profile is modified.



Fonts Menu
Click on any menu item for further information.



Select this option to change the font used for displaying the contents.    The font list will show all available 
fonts.

This option starts the Fonts dialog.



Select this option to change the font used for displaying character text in the viewer.    The font list will be 
limited to fixed-width fonts.

This option starts the Fonts dialog.



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on any term for further information.

- A -

Alchemy
Amiga IFF
AND
Archive
Aspect Ratio

- B -

BMP
Boolean Logic
Buffer Size
Buffer Underrun

- C -

CALS
CCITT
CD (Compact Disk)
CD-I (Compact Disk Interactive)
CD-R (CD-Recorder)
CD-ROM (Compact Disk Read Only Memory)
CGM (Computer Graphics Metafile)



Clipboard
Close CD
CLP
COLD (Computer Output to Laser Disc)
COM (Computer Output to Microform)
CUT

- D -

DAD (Digital Audio Disk)
DASD (Direct Access Storage Device) 
DAT (Digital Audio Tape)
Database
DCX
Defragment
DIB (Device Independent Bitmap)
Dithering
Document
Document Profile
DPI (Dots Per Inch)

- E -

Encapsulated PostScript (EPS)

- F -

Full-text Search

- G -

GEM
GIF
Group 4 Facsimile

- H -

Halo CUT

- I -

ICA
IFF
IM1
IM8
IM24
IM32
IMG
Indexing
Indexing Characters
IOCA
ISO
ISO 9660

- J -

JPEG (Joint Photographic Experts Group)

- K -

Keywords
Kodak Photo CD



- L -

LaserData
LaserView
Link
Lookup Field
Lookup Table

- M -

MAC Paint
MPEG (Motion Picture Experts Group)
MSP
Multimedia
Multisession

- N -

NOT

- O -

OCR (Optical Character Recognition)
OR

- P -

Parentheses
PCD
PCT
PCX
Photo CD
Photoshop
PICT
Pixmap
Premastering
Profile Search
Profile Template
PSD

- R -

RAID (Redundant Arrays of Inexpensive Discs)
RAS
RAST
RLE (Run-Length Encoding)

- S -

SCSI (Small Computer Standard Interface)
Search Result
Seek Time
Stop Word
Sun Raster

- T -

TARGA
TCP/IP (Transmission Control Protocol/Internet Protocol)
Template
TGA
Thermal Calibration



Throughput
TIFF (Tagged Image File Format)

- V -

VESA (Video Electronics Standards Association)
Virtual Folder

- W -

Wild Cards
Word Wheel
WORM (Write Once, Read Many)
WPG

- X -

Xbitmap
XBM
XPM

End of Glossary



Help Menu
Click on any menu item for further information.



Select this option to show the About dialog.



Select this option to run Windows Help with this file.



Select this option to run Windows Help to show the keyboard commands.



Select this option to run Windows Help to show Technical Support information.



Select this option to show how to use Windows Help.



How to Upgrade
Exclusive Upgrade Offer to Alchemy Personal Plus

For a limited time, HP SureStore CD Writer users can upgrade to Alchemy Personal Plus, our powerful $495 
version, for a very special price of $49.    You'll receive all the features listed under The Alchemy Family of Products.    
This offer will expire on December 31, 1995.

Call 1-800-910-0088 to place your order today.    MC/VISA accepted. (Outside the continental United States, call 1-
970-339-7150).

For ordering information about the following products:

Alchemy Gold
Alchemy Professional
DataGrabber

Call 1-303-689-0022, 8 am to 6 pm M-F Mountain Standard Time, or send a FAX to 1-303-689-0055.    (No technical 
support calls, please)

For more information about these products, click on The Alchemy Family of Products.



These settings may be used to specify a program to use in place of File Manager or Explorer.    This program 
could be any drag and drop source.    To use a different file manager, you need to know the name of the 
executable program, and the name of its main window class.    Contact the manufacturer of your replacement 
file manager for this information.



This setting should be set to 1 to enable Alchemy to skip files that are in use by other applications during a 
build.    If set to 0, Alchemy will ask before skipping a file.    This setting cannot be changed from within 
Alchemy.

If you use Alchemy to perform unattended builds, this option should be set to 1 so builds do not stop for 
locked files.



This setting is used to tell Alchemy how large of a buffer it should fill on the hard disk before writing it to CD-
R.    Normally, Alchemy builds the database with a buffer size of 8 megabytes.    You may want to increase this
number if you have sufficient hard disk space available.    To create a CD-ROM in a single session for 
mastering or to read on older drives, this number should be set larger than the anticipated database.



This setting will be set to 1 to close the session after writing to the CD, or 0 to leave the session open.

Warning: Closing the session will consume 14 to 23 megabytes of space.



This setting will be set to 1 to enable compression, or 0 to disable compression when writing the database.



Set this setting to 1 to enable display of the progress meter during writes to the CD recorder, or set to 0 to hide
the progress meter.    This setting cannot be changed from within Alchemy.



This setting can be set to 1 or 2 to record at single-speed or double-speed.



This setting will be set to 1 to write-protect after writing to the CD, or 0 to leave the CD able to accept more 
data.    This setting cannot be changed from within Alchemy.

Warning: A write-protected CD-ROM can never be written to again.



This setting will be set to 1 to write the database to the CD-Recorder, or 0 to write the database to the hard 
disk.



This setting contains font information for the Contents Window and Query Results List.    To change this font, 
close any open viewers and select Fonts from the Options menu.



This setting contains font information for the viewer.    To change this font, view a text file and select Fonts 
from the Options menu.



This setting will be set to 1 to invert the image, or 0 to display the image as is.



This setting will be set to 1 to enhance the images by scaling to gray, or 0 to show the image as is.    This 
setting cannot be changed from within Alchemy.

This setting will be set to zero if Alchemy is running at standard VGA resolution.



This setting will be set to 1 to show the scroll bars, or 0 to hide them.



This setting will be set to 1 to show the Alchemist, or 0 to hide the Alchemist.



This setting will be set to 1 to show file details in the Contents window, or 0 to display just the folder and 
document tree.



This setting should be set to 1 to show a horizontal scroll bar in the Contents window, or 0 to hide it.    This 
setting cannot be changed from within Alchemy.

If you have deeply nested folders, a horizontal scroll bar may be necessary to allow you to see those deeply 
nested folders.



This setting will be set to 1 to show the status bar, or 0 to hide it.



This setting will be set to 1 to show the toolbar, or 0 to hide it.



This setting will be set to 1 to show the tool tips, or 0 to hide them.



Image Menu
Click on any menu item for further information.

NOTE: To view images, your PC display must be configured for a minimum of 256 colors.    Images will not display 
properly at 16 colors.



Select this option to show bottom half of the image.    The image is scaled so the width of the image fits the 
current window.



Select this option to scale the full image to fit the current window.



Select this option to invert all pixels and produce a negative image.

A check mark beside this menu option means that the image is displayed in inverted mode.



Image Page Menu
Click on any menu item for further information.



Select this option to display page one of the current image document.

The number of pages in the document is displayed on the status line.



Select this option to go to any page in the image document.

The current page and the number of pages in the document are displayed on the status line.



Select this option to display the last page in the current image document.

The current page and the number of pages in the document are displayed on the status line.



Select this option to display the next page in the current image document.

The current page and the number of pages in the document are displayed on the status line.



Select this option to display the previous page in the current image document.

The current page and the number of pages in the document are displayed on the status line.



Select this option to rotate the current image left (counter-clockwise) by 90 degrees.



Select this option to rotate the current image right (clockwise) by 90 degrees.



Select this option to show the top half of the image.    The image is scaled so the width of the image fits the 
current window.



Select this option to zoom into the image.    The image is enlarged.    To enlarge a specific region of the image:
Move the mouse to one corner of the region.
Press and hold the primary button.
Drag the mouse to the opposite corner of the region.
Release the mouse.



Select this option to zoom out of the image.    The image is made smaller.



Indexing Details
Overview

For every group (or "session") of files that is recorded to CD (or saved to hard drive) using the Build CD-R Database 
function, Alchemy creates index files.    These index files contain the indexed full-text words, the DOS filename 
information, and links to the files in the database.

Alchemy compresses the index files to reduce the amount of overhead, and give you more room for the actual data 
files (which can also be compressed).    The index files are incrementally updated whenever you add more files to the 
CD.

Disk space requirements

The index files are kept in a subdirectory under where Alchemy (ALBUILD.EXE) is installed.    The subdirectory has 
the same name as the database.    The total size of the index files depends on variables such as the number of 
repeated and unique words in each file that is indexed by full-text.

Typically, the index file overhead will be less than 10% of the uncompressed original file size.    For example, if you 
recorded 100 megabytes (before compression) to CD, the index files should total less than 10 megabytes.

Note:    Make sure you have enough space on your hard drive to store the Alchemy index files.    The rule of thumb is
10% of the size of the original files.

Copying the indexes to CD

When a database build with Close Session is performed, Alchemy automatically copies the index files and the 
ALSEARCH program to the CD.    The CD now contains a completely portable database for others to query and 
retrieve.

Note:    Close Session will consume 14 to 23 megabytes of space on the CD.    If you plan to read the CD only in your 
CD recorder, there is no need to close the session.

Alchemy's Search program

Alchemy includes a runtime Windows retrieval program called Alchemy Search (ALSEARCH.EXE) that is copied to 
every CD and may be sent to anyone else to use.    Alchemy Search is Netware-compatible, so CDs can be read 
from a CD-ROM drive that is mounted as a network drive.    All the search functions are also embedded in Alchemy 
Build (ALBUILD.EXE).    You can build and search your CDs all in Alchemy Build.

CD-ROM capacity

The standard 74-minute blank CD-R will hold slightly more than 680 megabytes of digital data.    With a powerful 
indexing and retrieval program such as Alchemy, there will be some overhead for index files and the retrieval 
program.    In general, plan on at least 600 megabytes of data storage for each CD, with the rest reserved for index 
and retrieval overhead.    Before each recording session, the available capacity left on a CD is displayed in the Build 
Database dialog.    Alchemy has built-in, automatic data compression.    While your results will vary, typically your 
files will compress 2:1 or 50%.    This means the capacity of the CD can be increased to over 1 gigabyte of data.



Keyboard Commands
From the main menus:

Ctrl-S Save profile changes.
Ctrl-P Print search results list, blocked text or 

document.
Ctrl-C Copy selected text to the clipboard.
Ctrl-G Gather selected text into Notepad.
Ins Insert folder.
Del Delete folder or document.
F1 Help contents.

While browsing search result documents:

Ctrl-D Find the next occurrence of a search word.
Ctrl-U Find the previous occurrence of a search word.

While viewing a scanned image.

Ctrl-F View full image.
Ctrl-T View top of image.
Ctrl-B View bottom of image.
Ctrl-L Rotate image left.
Ctrl-R Rotate image right.
Ctrl-N Invert image.
+ Zoom in.
- Zoom out.



Menu Commands
Alchemy's Main Menu Bar

The main menu bar is displayed in Alchemy's main window.    Certain commands may be disabled at times, and will 
generally appear in a color different from other menu items.    Click on any menu item for further information.

Graphics Popup Menu

This menu pops up when you highlight a window containing graphics and press the secondary mouse button.    To 
highlight a window, press the primary mouse button while the mouse pointer is within the window.

Text Popup Menus

This menu pops up when you highlight a window containing text and press the secondary mouse button.    To 
highlight a window, press the primary mouse button while the mouse pointer is within the window.

If you have selected text in the window and press the secondary mouse button, the popup menu contains two more 
items for dealing with selected text.



Options Menu
Click on any menu item for further information.



Select this option to configure colors used in displaying document profiles and highlighted text found within 
document contents.

To change colors:
In the Color Element box, select which color you wish to change.
Select either Background or Foreground attribute to modify.
Click on the color you wish to select.    
Select the OK button to save the colors.

The selected colors will be remembered when you exit the program.



Select this option to set general and viewer preferences.    These preferences are saved automatically.

This option starts the Preferences dialog.



Select this option to restore the saved settings.    All displayed windows will be resized and moved according to
the settings in ALCHEMY.INI.



Select this option to save the current settings.    The program will save the arrangement (sizes and positions) 
of all windows to a disk file, called ALCHEMY.INI, which is located in the Windows directory.



Enable this option to display file sizes and dates in the Contents and Query Results windows.



Enable this option to show the tool tips, the yellow descriptive boxes that appear when the mouse cursor is 
placed on a toolbar icon.    This option is only available when the toolbar is enabled.



Select this option to enable or disable the Wizard that guides you through database creation and searching.    
A check mark beside this menu option means that the Wizard is enabled.



Overview
Welcome to Alchemy Personal for CD Recorders.    Alchemy is a complete CD-ROM recording and retrieval 
system that enables you to use inexpensive, portable CD-ROMs for backup, archival, extra on-line storage or the 
distribution of large amounts of data.    It provides for the organization and easy transfer of files to a CD-ROM, plus 
comprehensive search and retrieval capabilities.    Alchemy supports a wide variety of word processing formats, 
spreadsheets, ASCII text, graphics, images and other electronic file types.    All files are stored on CD with their 
original formats intact.    An Alchemy CD is completely self-contained, with all the software needed for retrieval.    CD-
ROMs created with Alchemy can be read on another CD-ROM reader installed on a Windows-based PC or a PC 
LAN.

Alchemy allows you to choose which files will be copied to the CD and organizes the files into a database structure 
analogous to a filing cabinet.    A Profile Card, similar to an electronic index card containing information that is helpful 
in both locating and searching, is created for each file.    Alchemy creates a full-text index of all the words contained 
in the documents, a Keyword list of descriptive terms that help in locating documents (especially those of a non-
textual type), and a fully configurable hierarchy of folders and sub-folders.    It allows you to set up the indexing criteria
according to your specific needs, automatically writes the files to the CD Recorder, and then provides search and 
retrieval of all files on the CD.    Search capabilities include simultaneous full text and profile searches, query-by-
example, full Boolean logic, and image retrieval by keywords or links.



Frequently Asked Questions
Q: Why won’t Alchemy index my phone numbers, dates, or account numbers?

A: The version of Alchemy distributed with the HP SureStore does not index "pure numbers" or the hyphen.    This 
feature is available in the $49 upgrade to Personal Plus.

Q: Why can’t I drag from the left side of File Manager?

A: The left side is an expandable tree, while the right side is a list.    The two behave differently in that the tree does 
not allow multi-select or drag & drop source, while the list does.    In other words, that’s the way Microsoft built it.

Q: Why didn’t Alchemy install its icons in my desktop?

A: Any Windows shell program is responsible for receiving the messages to install icons into a group.    Windows’ 
normal default shell, Program Manager, handles this well.    3rd-party shells, such as Norton Desktop and PC Tools, 
also work.    Other shells may not respond to these messages, so Alchemy does not get added to the interface as an 
available program.    The user would need to use the shell’s method of adding programs to the interface, specifying 
Alchemy Build as ALBUILD.EXE and Search as ALSEARCH.EXE, both in the Alchemy directory.

Q: Why can I not see all my files in my viewer?

A: Alchemy    supports viewers for    the most popular word processing, spreadsheet, and image formats.    If your file 
format is not supported Alchemy viewers,    your data will still be saved by    Alchemy    and left in its original format    

Q: Why do my images    look    fuzzy in the viewer?

A: Check to see under windows setup what video driver Windows is using.    If    you are using a 16 color driver, switch
to a 256 color driver.    The Super VGA (640*480, 256 colors) is recommended. 

Q: Why do I not see any bold, font sizes or images in my word processing document?

A: The Alchemy viewers are intended to give you a fast "draft mode" preview and do not show    the format codes in 
the document.    These codes are still intact on the CD.

Q: When do I want to close a session? or Why do I have to Close a session?

A: Two reasons.    1) Makes your CD readable in another CD-ROM drive, and 2) When Alchemy builds a database to 
a CD, it does not write all of the database files on the CD until a Close Session build is performed on the individual 
database.

Q: Why can't I read my CD in File Manager or Explorer?

A: If    you did not select the option close session the File Manager or Explorer cannot see that database.    Once you 
decide to close the session the database becomes visible to the FM. That database is always visible in the Info option
in Build dialog.

Q: Why can I just see the first session I built on my CD reader but all the sessions built show on my 
recorder?

A: The reader you are using is a single session reader.

Q: Why during a build is Alchemy having problems opening folders?

A: If it is word processing documents the check to see if the document is done with a fast save.    If you are running 
32-bit disk access change it to 16 - bit disk access.



Reporting Problems (Print this, fill it out, send it in)
Mail or fax to:

Information Management Research, Inc.
5660 Greenwood Plaza Blvd., Suite 210
Englewood, CO 80111
(303) 689-0055 Fax

Alchemy version (from Help/About)________________ Date: ____________________

Customer name, company, address, phone, fax, email address

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

Detailed description of problem, steps to reproduce

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

Hardware and software configuration

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

Please include any problem data files, printouts, or screen shots that might help
illustrate or help us reproduce the problem.



Requesting Features (Print this, fill it out, send it in)
Mail or fax to:

Information Management Research, Inc.
5660 Greenwood Plaza Blvd., Suite 210
Englewood, CO 80111
(303) 689-0055 Fax

NOTE: Do not use this form for technical support.

Alchemy version (from Help/About)________________ Date: ____________________

Customer name, company, address, phone, fax, email address

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

Detailed description of desired feature

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

______________________________________________________________________

Thank you for your input.    Due to the number of requests received at IMR, we regret
that we cannot respond to each user individually.



Search Menu
Click on any menu item for further information.



Select this option to query the database.

This option starts the Query dialog.



Select this option to view the results list from the last Query.



Space Requirements
Hard disk space requirements:

A database is built in segments or tracks on the hard disk before being written to the CD-R.    Documents are 
added to a track until the track size becomes larger than the Buffer Size setting in the Build Options dialog.    
Since a document is never split across tracks, the actual track size may be significantly larger than the Buffer 
Size setting.    In general, you must allow for the Buffer Size plus the size of the largest file added to the 
database.    Each track is automatically deleted after being written to the CD.
Additional disk space is also required to hold database indexes and temporary compression buffers.    This is 
dependent on the nature of the data and may range from 2% to 5% of the total size of the database.

If you run out of hard disk space:

Running out of hard disk space is not a fatal error.    Alchemy will display a warning message and will ask you to 
delete some files from your hard drive before retrying.    Make more disk space available using a DOS window or 
File Manager or Explorer before clicking the Retry button.

CD-ROM space requirements:

To successfully build a database to the CD-R, all documents, indexes and the search engine must be written to a
CD and the CD Session be closed.    Before writing any data to the CD, Alchemy estimates the CD space 
requirements for the database and displays a warning message if there is a possibility of running out of CD 
space.    Alchemy always reserves enough CD space to allow for the index files and closing of the CD Session.
See Also: CD Recording Tips

If you run out of CD-ROM space:

If you run out of space on the CD-ROM during the build, you need to delete from the Contents those documents 
that were not written to the CD-ROM, and build one last time to move the indexes to the CD-ROM and close the 
session. To delete unbuilt documents, select each folder containing those documents and press the delete key.    
If the folder contains a mix of built and unbuilt documents, the built documents will NOT be deleted from the CD-
ROM.    Deleted documents are only deleted from the Alchemy Contents - the original documents are NOT 
deleted.
To determine which documents have been built, turn on the Show File Details option in the Preferences dialog.
After deleting these documents, build one more time after checking the options to insure the Close Session 
option is enabled.    After this final build, you can delete the database and start a new CD-ROM with the 
documents that did not fit on the previous CD.    Other versions of Alchemy allow databases to span multiple 
CD-ROM discs.    Click on How to Upgrade for further information.



Supported File Formats
A Note About Text Indexing

Alchemy indexes the text contained in the popular word processing and spreadsheet file formats listed below.    
Alchemy will create a full-text index of every word in the supported files, allowing you to retrieve files by a text 
search.

A Note About File Viewers & Printing

Alchemy includes file viewers for the formats listed below.    The word processing and spreadsheet viewers are not 
WYSIWYG (What You See Is What You Get); they are intended to provide a fast "draft mode" preview and printout of 
the file's text contents.    Some versions of Alchemy allow you to launch a file into its native application for WYSIWYG
viewing.    The style (bold, underlines, font sizes and styles) and format codes of the document are still intact on the 
CD.    Embedded objects such as tables, graphs, images, media clips, or other documents are not displayed.    The 
image viewers will display and print an image according to the resolution and color configuration of your PC.

What if A File Is Not Supported?

Unsupported word processing and spreadsheet files cannot be indexed by text, viewed or printed from within 
Alchemy.    If you are not sure about a file format, drag the file into the Alchemy Contents and try to view it.    If the 
View window is empty, the file is not supported for text indexing, viewing and printing from within Alchemy.    You can 
still add that file to the CD and retrieve it by a search of either the filename, or user-provided descriptive document 
title field. Unsupported image files can't be viewed or printed, but can be stored and retrieved by filename or 
descriptive title.    To view and print unsupported files, use Retrieve Files to restore them to your hard drive and open 
them under the original application.    Note: the original file format is never altered by Alchemy.

The following file formats are supported in this version

Word Processing formats:

ASCII
Rich Text Format (RTF)
Microsoft Write
WordPerfect 5 for DOS & Windows
WordPerfect 6 for DOS & Windows
Microsoft Word for DOS
Microsoft Word for Windows 2.0
Microsoft Word for Windows 6.0
Enable WP
WordStar
WordStar 2000
Hex view of binary files

Spreadsheet formats:

Quattro Pro 4.0
Lotus Symphony
Lotus 1-2-3, Release 2 - 5
Microsoft Excel 4.0, 5.0

Image formats:

Windows BMP, RLE, DIB
PaintBrush PCX
DCX
TIFF, Group 3, Group 4, FAX
GIF
JPEG
Kodak Photo CD
Photoshop



Microsoft Paint MSP
Sun Raster
LV - LaserData
HALO Cut
CLP
Showpartner GX2
ICO
Kofax
EPS - Raster Only
PICT
TARGA
WPG - Raster WordPerfect Graphics
GEM IMG
IOCA
MAC Paint
CALS
XBM - Xbitmap
XPM - Pixmap
XWD
ATT (G4)
Amiga IFF



Adding and arranging folders
Adding a folder

To add a folder to the Contents window, either press the Ins key or select Add Folder... from the Edit menu.    This 
action displays the Add Folder dialog.

Enter the folder title and click the OK button or press Enter.    The title you enter here can be changed at any time.    
You can decide whether to position the new folder before or after the current folder, or you can arrange them later.

Putting one folder inside another

For this example, we have two folders.    We wish to move the Mountain Scenery folder inside the Pictures folder.

Click on the folder you wish to move with the primary mouse button, and hold the mouse button down.

The mouse pointer will change from an arrow to an arrow with a folder.

Drag the mouse pointer until it is over the destination folder.    Release the mouse button to drop the folder into the 
destination.    the destination is surrounded by a focus rectangle to aid in determining where to drop.

If the folder seems to disappear, you can find it again by opening the destination folder by clicking on the folder icon.   
The moved folder should be inside the destination folder.

Arranging the order of folders

Click on the folder you want to move with the primary mouse button, and hold the button down.

The mouse pointer will change from an arrow to an arrow with a folder.



Move the folder until the focus rectangle is where you want to insert the folder.    Release the mouse button.

The folder is moved from where it was to the new destination.

Working with two views of the contents

The Contents pane normally displays one view of the folder structure.    This view may only show a portion of the 
entire folder structure.    It may be necessary to drag a document or folder to a location that is not currently visible in 
the contents pane.    To accomplish this, it is necessary to open a second contents pane.    This is done using the 
splitter bar.

The splitter bar is a gray bar that is found at the far right-hand side of the contents pane.    When the mouse pointer is 
positioned over this bar, the pointer changes to a pointer with two arrows and a bar between them.    Click and drag to
the left to open the second contents pane.    Files and folders can be dragged from either contents pane and dropped 
into the other.

Renaming folders

Folders can be renamed before building to provide longer, more descriptive names.    Click on any folder and select 
Properties from the Edit menu.    Enter the new name and click OK.    The new name will be visible only if 
Options/Preferences/Show File Details is disabled.



Adding directories to folders
Adding directories to folders

Run the Windows File Manager or Explorer by clicking on the File Manager or Explorer icon on the toolbar, or by 
selecting Launch File Manager/Explorer from the File menu.    In File Manager or Explorer, click on the directory 
you wish to add.    Click and hold the primary mouse button to start the drag and drop operation.

Note:    You can only drag directories from the right side of the File Manager (the side that normally shows files).    If 
the directories are not visible on the right, select By File Type... from File Manager's View menu.    Click on the 
Directories checkbox to view directories in the file window.

After you click on a directory, the mouse pointer will change to a pointer with a folder.    Drag the pointer into the 
Alchemy Contents window.

Release the mouse pointer over a folder to add the directories to that folder, or release in an open space in the 
Contents window to add the directories to the top level.

The selected directory and all directories under the selected directory will be added to the Contents window.



Adding files to folders
Adding files using Drag & Drop

Run the Windows File Manager or Explorer by clicking on the File Manager or Explorer icon on the toolbar, or by 
selecting Launch File Manager/Explorer from the File menu.    In File Manager or Explorer, click on the file or files 
you wish to add.    Click and hold the primary mouse button to start the drag and drop operation.

Drag the mouse pointer until it is over the destination folder.    Release the mouse button.

The file or files will be added to the destination folder.    If the folder is open, you will see the files immediately.    If the 
folder is closed, you will see the files when you open the folder by double-clicking on the folder icon.



Arranging files
Arranging the order of files within a folder

Click on the file you want to move with the primary mouse button, and hold the button down.

The mouse pointer will change from an arrow to an arrow with a page.

Move the file until the focus rectangle is where you want to insert the file.    Release the mouse button.

The file is moved from where it was to the new destination.

Moving files to other folders

Click on the file you wish to move with the primary mouse button, and hold the mouse button down.

The mouse pointer will change from an arrow to an arrow with a page.

Drag the mouse pointer until it is over the destination folder.    Release the mouse button to drop the file into the 
destination.

If the file seems to disappear, you can find it again by opening the destination folder by clicking on the folder icon.    
The moved file should be inside the destination folder.

Renaming Files



File titles, which are initially set to the file names, can be changed before building to provide longer, more descriptive 
names.    Click on any file and select Properties from the Edit menu.    Enter the new title and click OK.    The new 
title will be visible only if Options/Preferences/Show File Details is disabled.    If enabled, only the original short file 
name will be shown.



Browsing the Contents Window
See Also: Contents Window and Supported File Formats

The Contents window contains folders and documents.    Folders are represented by an icon that looks like a manila 
file folder, and can be either open or closed.    If a folder is closed, it can be opened by double-clicking on it

After double-clicking on the closed folder, it opens to show its contents.    In this example, the Pictures folder contains 
three more folders.

After double-clicking on another folder, it opens to show that it contains documents.    Documents are represented by 
icons.    For a full list of the document icons, see Document Icons.

To view any document, click on it.    The window will split in the middle and the bottom pane will display the contents 
of that document.    In this example, a bitmap file is being viewed.

You can view numerous types of files.    This example is viewing a document created by an ASCII editor.



Complex queries
Complex queries allow you to search for multiple terms in multiple fields.

Searching multiple fields

To search multiple fields, place a search term in more than one search field.    The search treats this as an AND 
relationship.

For example, to find all Microsoft Word documents containing the word Doctor, enter Doctor in the full text field and 
doc (Word's native file extension) in the document title field.

Searching with multiple terms

Any search field can use a query containing search terms and Boolean operators.    Alchemy supports the use of the 
Boolean AND, OR, and NOT to construct complex queries.    Parentheses can be used to logically group parts of the 
query.

For example, to find all documents containing both Doctor and Smith, search for "Doctor AND Smith".    To find all 
documents containing either term, search for "Doctor OR Smith".    To search for all documents containing Doctor but 
not Smith, search for "Doctor AND NOT Smith".



Copying selected text
Selecting text to copy

Before you can select text to copy, you must be viewing a document from either the Contents window or the Query 
Results List.    You can view a document from either source by double-clicking on the document with the primary 
mouse button.

Once the document is visible, select text by clicking and dragging from the beginning of the desired text to the end of 
the text.    This process is identical to that used to select text in any Windows program.    Once some text is selected, 
you can either copy it to the clipboard or gather it into Notepad.

Copying to the clipboard

Copy selected text to the clipboard by either pressing Ctrl-C or by selecting Copy from the Edit menu.

Gathering selected text

If you plan on copying several pieces of text, the Gather option may be more efficient.    Gather text by selecting the 
text and either pressing Ctrl-G or selecting Gather from the Edit menu.    The first time you select Gather, Alchemy 
will start the Windows Notepad program and copy the selected text to the new Notepad document.    Further 
gathering will continue to copy the selected text to the Notepad document.

Note:    Notepad can create documents up to 50K in size.    For larger documents, copy the text to the clipboard rather
than using Notepad.



Creating a database
When you first start Alchemy, it will display the Database Definition dialog.    Enter the database title and file name.

The database is created under the Alchemy directory.    After you've created an empty database, you can drag in files
and directories from File Manager or Explorer.



Creating compound documents
A compound document is a document consisting of more than one file.    You can create a compound document by 
attaching any document to any other document by using drag & drop.

Creating compound documents using drag & drop

Select a document by clicking on it with the primary mouse button.

While holding down the mouse button, drag the document to the destination document.

Release the mouse button.    The destination document's icon changes to a book icon.

If you double-click on a compound document, it expands to show the attached documents.    Note that the picture has 
been moved from its original location and attached to the destination document.

Other compound document information

You can also attach compound documents to other documents.    If you drag a compound document to another 
location, all of its attachments follow.



If the documents you are dragging to and from are not both visible in the Contents window, use the splitter bar to view
two copies of the Contents.    Locate the source document in one pane and the destination document in the other 
pane.    Drag from the source pane and drop in the destination pane.



Deleting documents and folders
You may delete any document or folder that has not yet been built to the CD or hard disk.    Select the document and 
either press the Del key or select Delete from the Edit menu.

NOTE: The actual file or directory is NOT deleted from your source drive.    It is only deleted from Alchemy's 
Contents.



Distributing the database
When you first build an Alchemy database to a CD-ROM, a copy of the Alchemy Search program and all supporting
files is placed in the root directory of the CD.    When you're ready to distribute your database, select Close Session 
under Build/CD-R Database.../Options, and build one last time.    You can then distribute the CD as a self-contained 
database and retrieval engine.



Installing the search program from CD
Alchemy Search can be run from the CD-ROM by running ALSEARCH.EXE from the root directory of the CD.    
Alchemy Search can also be installed to the hard disk by running SETUP.EXE from the CD.

If you use Setup, it will install an Alchemy group in Program Manager containing icons for Alchemy Search, the 
Help file, and the ALSEARCH.TXT readme file.



Printing a document
Select a document from either the Contents window or the Query Results List by clicking on it with the primary mouse
button.

You can print the selected document by pressing Ctrl-P, selecting Print from the File menu, or pressing  on the 
toolbar.

Alchemy prints documents as they look when viewed.    Word processing and spreadsheet files are printed in draft 
mode.    Documents that cannot be viewed within Alchemy also cannot be printed within Alchemy.    Refer to 
Supported File Formats for more information.



Query results
The Query Results List

A successful search results in a new window, called a Query Results List, which contains a list of all documents 
matching the search terms.    Each item in the list contains the Document Icon and Title, and may contain file 
information if it is enabled in the Preferences dialog.

Browsing the Query Results

To view any document in the Query Results List, click or double-click on it (depending on whether single-click viewing
is enabled in Preferences).    To print or retrieve documents, select the document and use the Print or Retrieve 
options from the File menu.

Compound Documents

Master compound documents are represented by the book icon.    These documents contain other documents.    To 
view the master compound document, click or double-click on it.

When you view a master document, the top pane of the Query Results List splits, with the new right-side pane 
showing a list of all documents attached to the current master compound document.

To view any attached document, click or double-click on it in the right-side pane.



Retrieving files
Select a document or folder from the Contents window or the Query Results List by clicking with the primary mouse 
button.    Select Retrieve Files... from the File menu.    This option will display the Retrieve Files dialog, where you 
can select a destination directory.

If you are retrieving a folder, all of the subfolders and documents it contains will be copied to a directory of your 
choice.    If a subfolder's name is larger than 8 characters, you will be prompted to enter a legal directory name.

All documents are retrieved with their original file formats intact.



Simple queries
The simplest way to query the database is to use the lookup table.    Select Query from the Search menu or press

 on the toolbar.    This action will display the Query dialog.    From this dialog, you can search on the document's 
file name, title, or full text.

Click in one of the text boxes and press Alt-L or click the Lookup... button.    This action will display the Lookup 
dialog.    In this dialog, you can see if the desired search term is in the database.    You can navigate the index by 
typing in the text box or using the mouse to scroll the index.    If you type in the text box, the index will jump to the 
point where the typed characters would be.
When you find your search term on the list, double-click on it.    This will return you to the Query dialog with the search
term visible in the text box.    Click on the Search button to complete the search.



Viewing a document
Word processing and spreadsheet documents are viewed in a draft mode.    Images are viewed according to your 
PC's resolution and color configuration.

You can view any document at any time by any of the following methods:

Click on the document in the Contents window 
Use the up and down arrows to move the highlight to a document, then either select Document from the View 

menu, press     on the toolbar, or press the Enter key.
Either action will open a view of the document in the lower portion of the Contents window.    For further information 
on the Contents window, see Contents Window .

You can create a separate viewer window (called a "clone" view) for viewing a document.    To create a clone view of 
a document, move the mouse cursor to the upper bar of the view window you wish to clone.    When the mouse cursor
becomes a "hand", you can grab the window and drag it to another location.    When you view the next document, it 
will display in the original view window, leaving the clone window containing the previous document.

If you are experiencing trouble trying to view a document:

Make sure the View window pane is open (see Contents Window).
Refer to Supported File Formats to see if the document is supported by Alchemy's viewers.



Viewing a profile card
You can view any profile card at any time by either of the following methods:

Click on the document in the Contents window.    If the profile card is not visible, drag the slider bar from the right 
side of the window to open the profile viewing pane.

Select the document, then select Profile from the View menu or press  on the toolbar.

Either action will open a view of the profile card in the lower portion of the Contents window.    For further information 
on the Contents window, see the Contents Window topic.



Writing to a CD
To write the database to a CD-ROM, select CD-R Database from the Build menu or press  on the toolbar.    The 
Build dialog will allow you to write the database to a CD-ROM, or to write it to the hard drive for testing purposes.    
The Options button will display the Build Options dialog, where you can change default settings concerning 
compression and sessions.    To build the database, press the Build button.    After the database has been built and 
written to CD or the hard drive, press the OK button.

If you have created a database on your hard drive and wish to move it to the CD, just check the Write to CD-R option 
on the Build dialog and press the Build button.    All database files will then be written to the CD.

If you wish to write multiple databases to a single CD-ROM, you should close the session after each database.    All 
databases are then available to Alchemy Search.

NOTE:    If you wish to read the CD-ROM on another drive, you must first Close the Session.    This will consume 
23Mb of space if the session contains more than one buffer of data, or 14Mb if it contains only one buffer.



Tasks
Building the Database

Creating a database
Adding and arranging folders
Adding directories to folders
Adding files to folders
Arranging files
Deleting documents and folders
Creating compound documents
Viewing a document
Viewing a profile card
Writing to a CD

Searching the Database

Browsing the Contents Window
Simple queries
Complex queries
Query results
Retrieving files
Copying selected text
Printing a document

Other Tasks

Distributing the database
Installing the search program from CD



Technical Support
Contacting Customer Support
Extended Support Programs
How to Upgrade
Reporting Problems
Requesting Features
About Alchemy Personal for HP
The Alchemy Family of Products
About IMR



AND - A Boolean connector used in search criteria.    When AND is used between search words, only 
documents containing all words are retrieved.    For example, a search for CD-ROM AND Multimedia would 
result in all documents containing both terms.



Alchemy - 
A medieval chemical philosophy whose chief aim was the conversion of base metals into gold.*
Or
An apparently magical power.*

* WEBSTER'S II New Riverside Dictionary



Amiga IFF - A file format used by Amiga computers to store images, text, and music.    Files using this format 
have the extension IFF.



Archive - The process of selecting and moving files and documents from on-line storage (hard disks and file 
servers) to near-line or off-line storage (tape or optical drives).    Alchemy is an excellent system to store 
archived information onto CD-ROMs with built-in search and retrieval capability.



Aspect Ratio - The relationship of width to height.    When an image is displayed on different monitors or 
printed in different sizes, the aspect ratio must be kept the same.    Otherwise, the image will look "stretched" 
either vertically or horizontally.



Boolean Logic - A method to specify complex searches.    Search words are combined using Boolean 
connectors AND, OR, and NOT.



Buffer Underrun - a condition that can occur when a CD-Recorder has to stop recording due to an empty 
data buffer, which can render the CD-ROM unusable.    These errors, once common, are now rare due to 
advanced CD-Recorder hardware and software.



CALS - Computer-aided Acquisition and Logistics Support files are black and white images used by the U.S. 
Government.    They are compressed with using the Fax Group 4 format.    Files using this format have the 
extension CAL.



CCITT - A French acronym for the International Telegraph and Telephone Consultative Committee.    CCITT 
issues standards for telecommunications and facsimiles.



CD (Compact Disk) - A standard medium for storage of digital data (including voice and video) in machine-
readable form, accessible with a laser-based reader. 



CD-I (Compact Disk Interactive) - A technical specification, jointly developed by Philips and Sony, for 
simultaneous and interactive presentation of video, audio, text and data in a self-contained multimedia system.
Also known as the Green Book standard.



CD-R (CD-Recorder) - A term used commonly for any drive capable of writing a CD-ROM.    Also known as a 
CD-Writer.



CD-ROM (Compact Disk Read Only Memory) - A version of the Compact Disk standard intended to store 
large amounts of digital data for personal computers.    Also known as the Yellow Book standard.    A CD-ROM 
appears to the user as a read-only logical disk drive.    Over 600 Megabytes of data can be stored on a single 
CD-ROM.



CGM (Computer Graphics Metafile) - An ANSI standard (X3.1221986) developed to organize the content of 
structured graphics files.



CLP - This format is used by the Windows Clipboard application to save the contents of the clipboard.    Files 
using this format have the extension CLP.



COLD (Computer Output to Laser Disc) - Replacement for COM (Computer Output to Microform) that sends
output data directly to a WORM or CD-Recorder optical disc.    Commonly used to refer to the act of archiving 
data from large computers to optical media instead of tape, microfiche, or paper.



COM (Computer Output to Microform) - The process of converting text and digital data to images on 
microfiche or microfilm.    The data is often in the form of printed reports created on a large computer.



Clipboard - A temporary cache of data in memory or disk file where data is held while it's being copied from 
one place to another.    Typically, this term refers to the clipboard within Microsoft Windows.



Close CD - To fix the end of a track so that the CD-ROM is readable on other CD-ROM readers.    The CD-
ROM may also be written to again, space permitting.    Closing the CD will consume 23 megabytes of space if 
the session contains more than one buffer of data, or 14 megabytes if it contains only one buffer.



DAD (Digital Audio Disk) - Same as a Compact Disk (CD).



DASD (Direct Access Storage Device) - Any on-line data storage device.    A CD-ROM player that can be 
addressed is a DASD.    Term was originally used to refer to mainframe computer storage devices.



DAT (Digital Audio Tape) - A technology that records noise-free digital data on magnetic tape.    A DAT 
cassette can hold 2 gigabytes or more when adapted for data storage.



DPI (Dots Per Inch) - A measurement of output device (printers or monitors) resolution and quality.    Typical 
laser printers may support 300dpi or 600dpi, with monitors typically supporting 96dpi or 120dpi.



Database - An Alchemy database is an organized collection of similar information grouped together for rapid 
retrieval.    Alchemy's databases are optimized for CD-ROM and other optical media.    A CD-ROM may 
contain one or more databases.    Using Alchemy Gold or Professional versions, a single database can also 
span multiple CD-ROMs.



Defragment - the process of arranging files on the hard disk so that all files are contiguous (i.e., not scattered 
all over the disk).    Disk defragmentation should be done often to assure the best possible system 
performance.

MS-DOS and Windows 95 include a utility that can defragment your hard disk.    See your MS-DOS or 
Windows 95 manual for further information.



Dithering - Simulating gray tones by altering the size, arrangement or shape of background dots.



Document - Any end-product that is created in an application and can be stored as a file.    Alchemy extends 
the concept of documents to include all files.



Document Profile - A fully configurable electronic "index card" attached to every document added to an 
Alchemy database.    Certain fields must be filled in by the user; other fields are filled in automatically.



Encapsulated PostScript (EPS) - These files can contain vector and bitmap data, and may also contain a 
screen preview image, usually in TIFF format.    Files using this format have the extension EPS.    Alchemy 
can view the bitmap portion of EPS files.



Full-text Search - To locate documents stored in a system by searching for text that appears in them, rather 
than by searching for them by file name or other indexing technique.



GEM IMG - This format is used largely by applications running under the GEM operating system.    Files using 
this format have the extension IMG.



GIF - A file format created by CompuServe to store images containing up to 256 colors.    The GIF format is 
compressed using a LZW compression scheme.    Files using this format have the extension GIF.    While still 
popular, this format has been replaced by CompuServe with the PNG format, which does not have license 
restrictions.



Gold -
A soft, yellow, highly malleable and ductile metallic element that is used especially in coins and jewelry. *
Or
A hard, yellow, round, flat, highly valuable collection of your data.

* WEBSTER'S II New Riverside Dictionary



Group 4 Facsimile - A standard for encoding and compression of images on facsimile machines.    Group 4 
uses a two dimensional run-length encoding for compression of monochrome images.



Halo CUT - These files are used by a number of MS-DOS paint programs.    Files using this format have the 
extension CUT.



ICO - Microsoft Windows standard icon bitmap.    Icon files are uncompressed device-independent bitmaps.    
Files using this format have the extension ICO.

Originator: Microsoft Corp.
16011 NE 36th Way, Box 97917
Redmond, WA    98073



IOCA - These files contain black and white images only, and may be compressed with Fax Group 3 or Group 
4.    The files use the extension ICA.



ISO - International Standards Organization.



ISO 9660 - An international standard that specifies the logical format of files and directories stored on a CD-
ROM.    ISO 9660 replaces the older High Sierra proposal and is directly derived from it.    The standard strives
to achieve a high level of portability and platform independence.



Indexing - The process of building data structures for a database that contain the location of every word or 
other data item.    Indexes allow Alchemy to locate items rapidly without searching through the entire body of 
data.



Indexing Characters - The character set used to recognize indexable words (e.g. A - Z, 0 - 9).



JPEG (Joint Photographic Experts Group) - A proposed standard for compression of still images.    Files 
using this format have the extension JPG.    The JPEG compression scheme is lossy, which means it should 
only be used for large color images where the data loss may not be noticeable.



Keywords - A set of standard descriptive terms used on the Profile Card that can help to identify and locate 
documents, especially those containing very little text.



Kodak Photo CD - An image format used to hold photographs on CD-ROM.    Each image file contains five 
images at different resolutions.    The images are all 24-bits per pixel.    Files using this format have the 
extension PCD.

Page Resolution
0 768x512
1 384x256
2 192x128
3 1536x1024
4 3072x2048



LaserView/LaserData - Format used to contain raster images for printing.



Link - A method of attaching items together in a database.    The index, for example, contain links to the files in
the database.    These links are used to reach data for retrieval.



Lookup Field - a field containing data from a Lookup Table.    You might want to use a lookup table to index a
field if the number of possible values was small.    For instance, to index documents by department, a lookup 
table might have the entries Sales, Engineering, Admin, Marketing, and Operations.    The document can then 
be indexed by selecting a department from the drop-down list for that field.    To use a lookup field:

Create a lookup table and enter the possible values.
Create a new field, and attach it to the lookup table.
Add that field to both the Query and Profile templates.



Lookup Table - A table containing possible values for indexing.    For example, if documents were indexed by 
department, a Department lookup table would contain values like Sales, Marketing, Engineering, and Admin.    
When indexing the documents, the user could choose from these values, or enter a different value.



MAC Paint - File format produced by MacPaint on the Macintosh computer.    These images are black and 
white at a resolution of 720x576.    Files using this format have the extension MAC.



MPEG (Motion Picture Experts Group) - An image compression scheme for full motion video.



Microsoft Paint MSP - Graphics file format created by Microsoft Paint, an application included with Windows. 
Files using this format have the extension MSP.



Multimedia - Combining more than one media (text, data, audio, graphics and full-motion video) for 
dissemination of information.



Multisession - the ability to record data to the CD-ROM at multiple times.    Each session requires 14Mb of 
overhead, and a CD-ROM can contain up to 99 sessions..



NOT - A Boolean connector used in search criteria.    The query, CD-ROM NOT MULTIMEDIA, tells Alchemy 
to retrieve all documents mentioning CD-ROM except for documents that also mention MULTIMEDIA.



OCR (Optical Character Recognition) - The process of converting bitmap images of text to machine 
readable characters using optical sensing and pattern recognition.    Typically used on images produced by 
scanning printed pages.



OR - A Boolean connector used in search criteria.    When OR is used between two search words in a query, it 
asks for the retrieval of all documents that mention either of the two words.



PCX, DCX - The PCX format is created by ZSoft's PaintBrush.    The DCX variant, created by Intel, can 
contain multiple images and is commonly used by fax programs for storing incoming or outgoing faxes.    
These files are compressed using a simple run length encoding format.



PICT - Most commonly supported format for the Macintosh computer.    This format can contain both vector 
and raster images.    Files using this format have the extension PCT.



Parentheses - An element of a Boolean search criteria used to group search criteria together and alter their 
precedence.    For example, the query CAR AND (BOAT OR PLANE) is distinct from (CAR AND BOAT) OR 
PLANE.



Photoshop (PSD) - A bitmap format used for astronomical images.    Images can be uncompressed or 
compressed with a variable-length Huffman format.    Files using this format have the extension PSD.



Premastering - The process of formatting data and recording on a CD-ROM.    Data is organized into logical 
sectors, synchronization information is generated, an error detection and correction data block is calculated 
and added to the end of each sector.



Profile Search - A search method used to sort and retrieve documents via information contained in their 
Profile Templates.



Profile Template - A configurable dialog template which is used to prompt and search for profile data.    Each 
database has one Profile Template, but the same Profile Template may be used by multiple databases.

Also known as a Profile Card.



RAID (Redundant Arrays of Inexpensive Discs) - A storage device that uses several disk drives working in 
tandem to increase throughput and/or provide redundant backup.



SCSI (Small Computer Standard Interface) - A standard parallel interface that connects peripherals to 
microcomputers.    As many as eight peripherals can be connected to a single SCSI bus.    Most optical discs 
connect to computers using a SCSI bus.    The computer will normally require a SCSI adapter board to talk to 
SCSI peripherals.



Search Result - The list of documents found to match a query, also known as a Query Results List.



Seek Time - A measure of how quickly a disk drive's head can be positioned over data to read.    The seek 
time of a CD-ROM drive may vary from 200ms to over 1 second, while the seek time of a magnetic disk is 
typically 10 - 20ms.



Stop Word - A word that Alchemy ignores while indexing documents.    Stop words normally include English 
prepositions, conjunctions,    articles and certain verbs.    OF, AND, IS, THE, WITH are typical stop words.    
Alchemy comes with a list of stop words, and this list may be modified by the user.    The stop word list is used
to keep the index from becoming cluttered with multiple occurrences of words with little or no information 
content.    By not indexing these common words, the index is smaller and retrieval is faster.



Sun Raster - Standard raster graphics format for Sun workstations.    Files using this format can have 
extensions of RAST, RAS, IM, IM1, IM8, IM24, or IM32



TARGA - Format used by Truevision Graphics Adapters.    They may be compressed using Run-Length 
Encoding.    Files using this format have the extension TGA.



TCP/IP (Transmission Control Protocol/Internet Protocol) - A set of protocols to link dissimilar computers 
across networks.    This is the default protocol used by the Internet.



TIFF - Stands for Tagged Image File Format.    These images can be uncompressed, or can be compressed 
with PackBits, Modified Huffman, JPEG, LZW, Fax Group 3 or Fax Group 4.    Files using this format have the 
extension TIF.



Template - Dialog that can be changed by the user.    Alchemy supports two templates - Profile and Query.    
The Profile template shows in the viewer area of the Contents or Query Results windows, and is used to 
modify fields prior to indexing.    The Query template shows in the Query dialog, and is used to search the 
database.    Both templates may be modified by the user.



Thermal Calibration - Operation performed by some hard disks to adjust for differences in temperature.    
This can interrupt the CD-ROM recording process, resulting in a data underrun and rendering the CD-ROM 
unusable.



Throughput - A volume of data that can be written to or read from a device in a fixed period.    Single speed 
CD-ROM readers have throughput of 150 kilobytes per second.    Double speed CD-ROM readers can support
up to 300 KB/s.    Also known as the "data transfer rate".



VESA (Video Electronics Standards Association) - A consortium of manufacturers formed to establish 
standards for super VGA monitors and display adapters.



Virtual Folder - A logical structure imposed on a document set to provide a hierarchical classification scheme 
similar to a disk directory structure.    The database folder hierarchy can be modified at any time prior to 
recording on a CD-ROM.    The virtual folder hierarchy becomes the Contents once the database is recorded 
on a CD-ROM.



WORM (Write Once, Read Many) - An optical storage device with both write and read capabilities.    There 
are no standards about WORM media formats - every drive uses different discs and formats.



WPG - Graphic format produced by WordPerfect applications.    This format may include both vector and 
bitmap images.    Bitmap images are compressed using simple run-length encoding.    Files using this format 
have the extension WPG.    Alchemy can view the bitmap portion of WPG files.



Wild Cards - Characters used match multiple choices, such as used in the DOS file system.    Both single 
character (?) and multi-character (*) wild cards are supported.    Wild cards are used in queries to search for 
variations of a term.



Windows BMP, RLE, DIB - Graphics file formats that are "native" to Windows.
B
M
P

Uncompressed bitmap.

R
L
E

Bitmap compressed with Run-Length 
Encoding.

D
I
B

Device Independent Bitmap.    You'll rarely 
see these.    Most programs generate BMP 
files instead.



Word Wheel - Another name for the index lookup list.    This name came from the viewpoint that, as the user 
types, the list "spins" like a wheel to the entries matching the user's text.



XBM Xbitmap - Black and white image format that consists of readable ASCII text and legal C source code.    
Files using this format have the extension XBM.



XPM Pixmap - An extended version of the XBM bitmap for color bitmaps.    This format is both readable ASCII 
and legal C code.



The Alchemy Family of Products
Your version, Alchemy Personal for HP, was developed by IMR expressly for the HP SureStore CD Writer, and is part 
of the award-winning Alchemy family of CD-R software solutions.    Your application may require the features found in 
one of the following products.

For upgrade ordering information, click on How to Upgrade.

Alchemy Personal Plus - the most powerful desktop CD-R application

Writes and retrieves data across multiple CDs; no other software in this price range can do this!
Builds and manages multiple databases.
Clear Database feature allows you to "test" and experiment before recording.
Indexing methods, Profile cards, and Query can be all customized.

Alchemy Gold - for workgroup and departmental applications

For LAN archiving, backup, computer report distribution, imaging storage.
May be installed on a file server.
Includes a concurrent retrieval program.
CD-SPAN retrieval for jukeboxes or CD towers.
DataGrabber interface for COLD or large imaging jobs.
Forms overlay designer.
Password protection security.

Alchemy Professional - service bureau license

12-month license to sell Alchemy databases and CDs.
All the functionality of Alchemy Gold.
Unlimited CD replication and distribution.

DataGrabber - computer report/imaging index conversion

Parses any ASCII text file directly into an Alchemy database.
Automatically links image files, indexes, and OCR files.
Requires Alchemy Gold or Professional.

For ordering information about the following products:

Alchemy Personal Plus
Alchemy Gold
Alchemy Professional
DataGrabber

Call IMR at 1-303-689-0022, 8 am to 6 pm M-F Mountain Time, or send a FAX to 1-303-689-0055. (No technical 
support calls, please) or send email to imrgold@aol.com



The Stop List
The Stop List is a list of common words that are not indexed.    Alchemy uses the following stop list:

a
all
also
an
and
any
are
as
at
be
been
but
by
can
cannot
could

did
do
does
for
had
has
have
he
her
him
his
how
if
in
is
it

its
let
me
my
no
not
of
on
or
our
she
so
some
than
that
the

them
then
there
they
this
to
us
was
we
why
will
with
would
yes
you
your

In Alchemy for HP, you cannot modify the Stop List.    If you wish to change the Stop List, upgrade to Alchemy 
Personal Plus, Gold, or Professional versions.    Click on How to Upgrade for further information.



The User Interface
Menu Commands
Keyboard Commands
Toolbar Commands
Dialogs



Toolbar Commands
Alchemy's Main Toolbar

The toolbar is displayed in Alchemy's main window.    Certain commands may be disabled at times, and will generally
appear in a color different from other toolbar icons.    Click on any icon for a detailed description.

    

    

    

    

    

    



Using Windows 95
Alchemy has been tested under Windows 95.    No special procedures are required to run Alchemy under Windows 
95.

Features for Windows 95

Alchemy has special capabilities if the program is run under the Windows 95 operating system.

Alchemy will automatically use the Explorer in place of File Manager as a drag and drop source.
Alchemy fully supports long file and directory names.    You can use Alchemy to backup and restore Windows 
95 programs.

Alchemy Quirks under Windows 95

Alchemy uses OLE to view some documents.    The files necessary to view OLE documents were installed when
you installed Alchemy, if they were not already present on the system.    Windows 95 now installs these files, so 
Alchemy's OLE files would not be installed under 95.    When you create a CD, Alchemy places all the files 
necessary for it to run on the CD, including the OLE files.    Under Windows 95, the OLE files shipped with 
Windows 95 are backward compatible with Windows for Workgroups, but not Windows 3.1 or 3.11.    Therefore, 
CDs made under 95 may not work under Windows 3.1, unless:
The user already has the OLE libraries on their system, and...
The user installed Alchemy Search using its Setup program.



View Menu
Click on any menu item for further information.



This option allows you to see where a viewed document was found in the Contents.    Select the window 
containing the viewed document.    Choose this option from either the toolbar or View/Contents from the 
menu.    The folder containing this document will open in the Contents and the document will be highlighted.



Select this option to show the current database information.
Document Count is the number of files written to the database.
Tracks Written is the number of tracks written to the CD.    Each CD can hold up to 99 tracks.
Uncompressed Size is the total number of bytes taken up by the included files.
Compressed Size is the number of bytes for the included files after compression has been applied.

This option starts the Database Info dialog.



Select this option to view the content of the highlighted document.    This button is a toggle that appears as 
either raised or depressed in the toolbar, and as checked or not checked in the menu.



Select this option to highlight the next occurrence of a search word within the document.

This command is only available while viewing a document found using full-text query.



Select this option to display the contents and/or profile of the next file in the Contents window.



Select this option to go to the next document on a search results list and display its profile, content or both.



Select this option to highlight the previous occurrence of a search word within the document.

This command is only available while viewing a document found using full-text query.



Select this option to display the contents and/or profile of the previous file in the Contents window.



Select this option to go to the previous document on a search results list and display its profile, content or 
both.



Select this option to view the profile of the highlighted or displayed document.    This button is a toggle that 
appears as either raised or depressed in the toolbar, and as checked or not checked in the menu.



Enable this option to show the Status Bar.    The following are displayed on the Status Bar:
A single line description of the menu command or toolbar buttons under the mouse pointer.
Line or page information about displayed documents.
Resolution information about displayed images.



Enable this option to display the Toolbar, which includes buttons for some of the most commonly used 
commands.



Window Menu
Click on any menu item for further information.



Select this option to arrange into rows all windows that have been minimized.



Select this option to arrange open windows so that the title bar of each window is visible. 



Select this option to close all open windows.



Select this option to arrange open windows side by side so that all of them are visible.    To arrange windows 
horizontally, press either Shift key while selecting this option.



Select a window from the window list.    The window list contains an entry for every open window.    If you 
select a window, that window will be brought to the focus.






